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About this user manual

This user manual is meant for anyone who has to do with installing,
programming and / or operating the Actilume Color system.
However, not all sections are equally relevant for all users.

Tips on using this user manual
- Figures ( , , etc.) before an instruction indicate a sequence

of actions, necessary to perform a certain operation;
- Dots (•) before an instruction indicate remarks, additional

information, advise or special options.
The dot-marked instructions are not necessary to perform the
operation.

- Dots (•), followed by italic text indicate a reaction from the
Actilume Color controller or the end result of a series of actions.

- Notes ( ) give particularly important information about what is
being described.

- Names of buttons, connectors, etc. are printed as they appear on
the Actilume Color controller, remote control, etc. and are
presented in bold type. For example: IR SENSOR, X 6, etc.

- Names of ‘buttons’, menus, submenus, etc. are printed as they
appear on the screen (when using Actilume Color Studio) and are
presented between apostrophes. For example: ‘OK’, ‘Help’, etc.

Navigating through the manual
• On the content page, just click on a section title to go there.
• References to the various sections of this user manual throughout

the text are directly linked to these sections. Just click the section
to go there.

We recommend that you keep this user manual for future reference.

21
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4 Important information

1 Important information

Please read the following instructions carefully, and retain them for
future reference.

1.1 Safety precautions
Observe the following guidelines to ensure that the controller will
operate safely and to prevent defects.
• Read and observe all warnings on the controller and in this user

manual.
• Do not use the controller in environments outside the following

range: temperature: 0 °C to 50 °C, relative humidity: 20% to 80%
humidity.

• Do not use or store the controller in / under:
– direct sunlight exposure;
– very humid and dusty environment;
– near any kind of heat sources.

• Protect the controller from oil, vapour, steam, moisture, and dust.
• Do not place inflammable, explosive or hazardous objects near the

controller.
• Do not operate the controller if it has been subjected to shock or

damage.
• Do not throw or shake the controller

1.2 Copyright
Copyright © 2008 by Philips Lighting B.V.
All rights reserved. No part of this publication may be reproduced,
transmitted, transcribed, stored in a retrieval system or translated
into any language or computer language, in any form or by any means,
electronic, mechanical, magnetic, optical, chemical, manual or
otherwise, without prior written permission from Philips. Brands and
product names are trademarks or registered trademarks of their
respective companies.

1.3 Disclaimer
Philips makes no warranty of any kind with regard to this material,
including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose.
Philips assumes no responsibility for any error that may appear in this
document. Philips makes no commitment to update nor to keep
current the information contained in this document.

1.4 Limitations of damages
The vendor will not be liable for any indirect, special, incidental or
consequential damages (including damages for loss of business, loss of
profits, or the like), whether based on breach of contract, tort
(including negligence), product liability or otherwise, even if the
vendor or its representatives have been advised of the possibility of
such damages and even if a remedy set forth herein is found to have
failed its essential purpose.

1.5 Environmental information 
Disposal of your old product 
The product is designed and manufactured with high quality materials
and components, which can be recycled and reused.

Please inform yourself about the local separate collection system for
electrical and electronic products.

Please act according to your local rules and do not dispose of your
old products with your normal household waste.The correct disposal
of your old product will help prevent potential negative consequences
for the environment and human health.

1.6 Disclaimer of warranty
The software on the CD-ROM supplied is sold ‘as is’ and without
warranties whether expressed or implied. Because of the various
software and hardware environments into which this program may be
put, no warranty of fitness for a particular purpose is offered.
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2 Actilume Color system

2.1 Introduction
The Philips Actilume Color is a DALI controller for color based
lighting applications.The system consists of a color controller,
designed for easy integration into luminaries, the Actilume Color
Studio programming software and a RS232 gateway.
The Actilume Color controller can be operated with a remote
control, or with either Philips MultiDim or DMX user interfaces.
The Actilume Color is a true Plug and Play solution for retail and
hospitality, which can control up to 10 luminaires per controller.
For larger systems, the Actilume Color controller can operate within
a MultiDim, and DMX (RDM) network. Full DALI Color (IEC 62386-
209) network compliance is not yet implemented, but is expected in
2009 when Dali Color is completely accepted and implemented..
No commissioning is required for the DALI based lamp drivers
connected to the Actilume Color Controller, which makes it easy to
use and easy to install.

2.2 Features and benefits
• Philips Actilume Color is a flexible Stand-alone, MultiDim and

DMX based DALI lighting control system designed for dynamic
and static color effects in small, medium-sized and large
applications.

• Actilume Color is a flexible Plug & Play system; therefore no
specific lighting control training is needed. Moreover, the system is
supported with simple, dedicated application and installation
sheets. In addition, the Actilume Color system can also be
operated in larger and existing MultiDim or DMX backbone
networks.

• The simplest system is operated by an infrared remote control to
recall 10 preprogrammed dynamic sequences and 10 static scenes.

• Actilume Color has open interfaces that allow to use your own
(proprietary) user interface based on RC5 (infrared remote
controls), DMX or Dali (Color).

• Per Actilume Color controller, a maximum of 10 color luminaires
can be controlled via the DALI R(ed), G(reen), and B(lue) output
ports. In addition, 40 Actilume Colors can be connected to the
DALI Ext port.This allows for a second level of Actilume Color
controllers (repeater function).When the DALI (Color) standard
is fully implemented it is also possible to connect other LED
fixtures to enlarge flexibility of the system.

• Easy to use programming of own dynamic color sequences with
Actilume Color Studio software.The files of the programmed
sequences and earlier chosen color palettes can be shared easily
via internet/email.

• By switching from one sequence to another, the system fades to
the starting point of the next sequence at whatever color you
make the interrupt.With this no direct color switch will be
observed.

• For larger systems within shops or public areas, it is possible to
commission the Actilume Color controllers within an existing
network.This also allows creating groups.

• Large building facades can be lit by using a MultiDim control to
synchronize up to 60 Actilume Color controllers (or 600 RGB
fixtures). Furthermore, the MultiDim controller can provide a
scheduler function, and other sensors.

2.3 Applications
• The Actilume Color system has been designed for all indoor

application within retail, hospitality, and public spaces, especially to
attract people and to surprise them.

• It can be used for both dynamic sequences from very short to
very slow (24 hr cycle), and static colors that are selected to
support e.g. seasonal fashion, merchandize change, or a specific
atmosphere in a bar or restaurant.

• It offers max. 16 preprogrammed sequences corresponding with
seasons (Christmas, autumn) and daily situations (nature, sun set).

2.4 Plug & Play control regimes
• Simple systems with one Actilume Color controller are typically

operated by MultiDim push button controls or remote control.
The lamp drivers are directly connected to the Red, Green, or
Blue outputs without any commissioning.

• LED drivers equipped with DALI Color can easily be connected
to the Actilume Color Controller, and can fully be integrated in
the pre-programmed scenes or dynamic sequences.
(Full implementation expected at the beginning of 2009.)

• Larger systems with all luminaries providing the same color can
be realized by connecting up to 40 Actilume Color Controllers
(to the DALI-ext port) on one ‘master’ Actilume Color controller,
which is operated by a MultiDim push button or a remote
control.

• Larger systems with different colors do not need any
commissioning by using DALI broadcast commands.
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3 Overview

Actilume Color controller LLC 1670/00

DMX input
Connects to a DMX control panel when the controller is
integrated in a DMX network.
Power input connector
Connects to the AC power supply:
L (live): live wire connector (red);
N (neutral): neutral wire connector (blue).
NC (not connected)
IR (Infrared) sensor
Connects to the remote control receiver.The receiver receives
commands from the remote control.
DALI connectors
R(ed) DALI + output: connects to the DALI input of the red

lamp driver in the fixture.
G(reen) DALI + output: connects to the DALI input of the

green lamp driver in the fixture.
B(blue) DALI + output: connects to the DALI input of the blue

lamp driver in the fixture.
Ext(ernal) DALI +
output: universal DALI output port 
C(ommon)_DALI + input:DALI return path connector. Connects

to the DALI outputs of the red, green
and blue lamp drivers in the fixture.

GP (General Purpose)_
DALI inputs (2x): connect to the + and - connectors of

the DALI control.

4

3

2

1 230V gateway LCU 1670/00

For connecting your computer to the Actilume Color system.

230VAC/50Hz N / L connectors
Connect to the AC power supply.
DA- / DA+ connectors
Connect to the DA inputs of the Actilume Color controller.
RS232 connector
Connects to the serial (RS232) port of a computer.

3

2

1

RS232

DALI Test Master

DA-

230VAC/50Hz
N

L  

DA+
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24V gateway LCU 1671/00

For connecting your computer to the Actilume Color system.

24VDC connectors
Connect to a 24VDC power supply.
DA- / DA+ connectors
Connect to the DA inputs of the Actilume Color controller.
RS232 connector
Connects to the serial (RS232) port of a computer.

CD-ROM with Actilume Color Studio software LCS1670/00
and user manual

Infrared Sensors

The following fixture based sensors can be used:

IRR 1654/00

Connection cord
Connects to the IR SENSOR input of the Actilume Color
controller.
IR (Infrared) sensor
Receives the signals from the remote control.
Protective cap3

2
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Actilume Color Studio
 LCS1670/00

3

2

1

RS232

IRR 1651/00

Connection cord
Connects to the IR SENSOR input of the Actilume Color
controller.
IR (Infrared) sensor
Receives the signals from the remote control.

IRR 8125/10

Connection cord
Connects to the IR SENSOR input of the Actilume Color
controller.
Extended IR (Infrared) sensor
Receives the signals from the remote control.

2

1

2

1
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Remote control IRT 1670/00

ON
Switches the Actilume Color system on.
X 1/2
Halves the playing time of a color sequence.
X 3
Multiplies the playing time of a color sequence by a factor 3.
X 6
Multiplies the playing time of a color sequence by a factor 6.

Dim up. Increases the light output of the connected fixtures.

Hue adjust - (counterclockwise).Adjusts the light tint.

Store. Stores the current color as a static color under one of the
Preset keys.

Hue adjust + (clockwise). Adjusts the light tint.

Dim down. Decreases the light output of the connected fixtures.
S(tatic)
Selects static mode. Static mode is only obtained if a Preset key
is pressed within 2 seconds.

4

3

2

1

Preset keys
All presets are preprogrammed at the factory. Colors and
sequences can be overwritten as described in 6.1.7 ‘Changing
presets’.

Preset keys for Static and Dynamic mode.
Preset 1
- Static mode: ‘Red’.
- Dynamic mode: ‘RGB’ (red - green - blue) in a 10 minutes

sequence.
Preset 2
- Static mode: ‘Green’.
- Dynamic mode: ‘Color wheel’ (red - yellow - green - cyan -

blue - magenta) in a 10 minutes sequence.
Preset 3
- Static mode: ‘Blue’.
- Dynamic mode: ‘Nature’ (green - cyan - blue - aqua marine) 

in a 10 minutes sequence.
Preset 4
- Static mode: ‘Yellow’.
- Dynamic mode: ‘Spring’ (yellow - green) in a 10 minutes

sequence.
Preset 5
- Static mode: ‘Cyan’.
- Dynamic mode: ‘Summer’ (green - warm white - red) in a 

10 minutes sequence.
Preset 6
- Static mode: ‘Magenta’.
- Dynamic mode: ‘Autumn’ (yellow - orange - red)  in a 

10 minutes sequence.
Preset 7
- Static mode: ‘Orange’.
- Dynamic mode: ‘Winter’ (blue - cold white) in a 10 minutes

sequence.
Preset 8
- Static mode: ‘Aqua marine’.
- Dynamic mode: ‘X-mas’ (green - red) in a 10 minutes

sequence.
Preset 9
- Static mode: ‘Cold white’.
- Dynamic mode: ‘Cold white / warm white’ (cold white - warm

white) in a 10 minutes sequence.
Preset 10
- Static mode: ‘Warm white’.
- Dynamic mode: ‘Various’ (red - yellow - green - cyan -blue -

magenta - warm white - cold white - orange -
aqua marine) in a 10 minutes sequence.

D(ynamic)
Selects dynamic mode / color sequence. Dynamic mode is only
obtained if a Preset key is pressed within 2 seconds.
OFF 
Switches the Actilume Color system into Standby mode.

Also refer to 5.1 ‘Remote control operation’.

Note:
When replacing the batteries, make sure to use AAA type batteries.

7

6

5



4 System setup

4.1 Mounting the controller into the fixture
Connect the DALI output connectors (R DALI +, G DALI + and 
B DALI + ) to the corresponding DALI input connectors of the
red, green and blue lamp drivers in the fixture.
Connect the DALI return path connector (C_DALI –) to the
DALI outputs of the red, green and blue lamp drivers in the
fixture.

• For connection, use cord types as described in XX ‘Data sheets’.
Connect the IR SENSOR connector to the remote control
receiver.This is only necessary if the system is going to be
controlled via the remote control (IRT 1670/00).
If the system is going to be controlled via MultiDim, connecting
the IR sensor is not required.

OR:

Connect the GP_DALI inputs of the controller to the + and -
connectors of a MultiDim or other DALI control system. In this
case it is not necessary to connect a remote control receiver.

3

3

2

1
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To lamps
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Remote control receiver
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System setup 9
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4.2 Basic system 1
• 1 fixture with 1 Actilume Color controller and red, green and

blue lamp drivers.To this fixture other fixtures can be connected
with a maximum of 9.These fixtures only contain lamp drivers
and lamps.

4.3 Basic system 2
• To extend the system, 1 Actilume Color controller can be

assigned as master (see picture).To it's Ext DALI + output, a
maximum of 40 Actilume Color controllers can be connected.
These 40 controllers will act as a slave.To each slave controller a
maximum of 10 fixtures can be connected, including the fixture
containing the slave controller.

8...9 mm (0.32’’-0.35’’) 

Insertion 0.5...1.0 / AWG20-18
IDC 0.5  /  AWG20

R_DALI+
G_DALI+
B_DALI+

Ext_DALI+
C_DALI–

GP_DALI  
GP_DALI  
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5
6
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DA / N

DA / Ls
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8 ~
~
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5
6

7
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9

8 ~
~

4

5
6

7

D A L I

14

13
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DA / Ls
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Master controller

DALI

DALI power supply

MultiDim Control

Max. 9 fixtures

Remote control receiver

Red, green and blue lamp drivers 

To lamps

Master controller in fixture.

Slave controller 1 in fixture. x 9 fixtures

Fixture

Slave controller 2 in fixture.

Slave controller 40 in fixture.

x 9 fixtures

x 9 fixtures

OR:
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4.4 DALI network
• Preprogrammed static and dynamic presets.
• Up to 40 DALI devices.

• The protocol on the Ext_DALI + output is according to:
IEC62386-102 ->
- Command 257 ‘DATA TRANSFER REGISTER (DTR)’ (0xA3 xx);
- RED dim level (xx : 0x00 - 0xFE);
- Command 273 ‘DATA TRANSFER REGISTER 1 (DTR1)’

(0xC3 xx) GREEN dim level (xx : 0x00 - 0xFE);
- Command 274 ‘DATA TRANSFER REGISTER 2 (DTR2)’

(0xC5 xx) BLUE dim level (xx : 0x00 - 0xFE);
- Command 272 ‘ENABLE DEVICE TYPE 8’ (0xC108).

IEC62386-209 ->
- Command 235 ‘SET RGB DIMLEVEL’ (0xFFEB).

DALI power Supply Universal LED 
driver

Actilume Color controller
        

RGB

Fluo



12 System setup

4.5 DMX network
• Instant control of the lighting system via DMX control panel.
• Up to 150 fixtures.
• In this configuration all (via controllers and drivers) connected

lamps will have the same static color or play the same sequence.
• To create specific colors or sequences, the DMX control panel

has to be replaced by Philips' LCS9601/00 MULTI-UTILITY
MANAGER (913700329403).

LEXEL LED
family

Lamp + 
DMX driver

Xitanium
LED driver

Actilume Color

DMX control panel

BGR



5.1.4 Selecting preset static colors
For an overview of preset static colors, refer to 3 ‘Overview’.

Press the ‘S’ key to select ‘Static’ mode.
Press a Preset key within 2 seconds to select the preset static
color of that key.

5.1.5 Selecting preset dynamic colors / color sequence
For an overview of preset dynamic colors / color sequences, refer to
3 ‘What’s available / Functional overview’.

Press the ‘D’ key to select ‘Dynamic’ mode.
Press a Preset key within 2 seconds to select the preset color
sequence color of that key.

5.1.6 Adjusting the playing time of a Color Sequence

• Press X 1/2 to halve the playing time of the ‘Color sequence’.
• If the playing time was e.g. 10 minutes it will now be reduced to 

5 minutes.
• Press X 3 to extend the playing time of the ‘Color sequence’ with

a facor 3.
• If the playing time was e.g. 10 minutes it will now be extended to 

30 minutes.
• Press X 6 to extend the playing time of the ‘Color sequence’ with

a facor 6.
• If the playing time was e.g. 10 minutes it will now be extended to 

60 minutes.

Note:
Pressing the X 1/2, X 3 or X 6 keys several times in a row will not
have a cumulative effect.

• Press the ‘D’ key to select ‘Dynamic’ mode and press a Preset
key within 2 seconds to return to the default playing time.
Also refer to 6.1.6. ‘Selecting dynamic colors / color sequence’.

2

1

2

1
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5 Operating the Actilume Color system

Once installed, the Actilume Color controller can be operated in
various ways.

5.1 Remote control operation
The remote control supplied uses the (open) RC5 protocol for IR
(infrared) data communication.
The remote control system codes are allocated to Lighting
applications only (system code 29 and 30) and will therefore not
interfere with other devices using an RC5 remote control
(e.g. DVD players,VCRs, Multimedia Centers, etc.).
For an overview of keys and functions, refer to 3 ‘Overview’.

Note:
When operating the system using the remote control, make sure
to aim the remote control at the IR sensor of the Actilume Color
controller.

5.1.1 Switching the Actilume Color system on and off

• Connect the system to the power supply.
• The system switches on automatically, the lamps in the system light

up and sequence 1 starts playing.
• Press the OFF key to switch the Actilume Color system into

Standby mode.
• The ‘Color Sequence’ stops playing and all lamps will be switched off.

• If you press the ON key again, the system will enter ‘Static’ mode
and the lamps will light up in the same color they had before the
controller went into Standby mode.

• To switch off the system completely, disconnect the controller
from the AC power supply.

5.1.2 Adjusting the light output

• Press the ‘ ’ key to increase the light output of the connected
fixtures.

• Press the ‘ ’ key to decrease the light output of the connected
fixtures.

5.1.3 Adjusting the light tint (hue)

• Press the ‘ ’ key to adjust the light tint (hue) by stepping
through the color wheel counter clockwise: red-yellow-green-
cyan-blue-magenta-red.

• Press the ‘ ’ key to adjust the light tint (hue) by stepping to
through the color wheel clockwise: red-magenta, blue, cyan, green,
yellow, red.
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5.1.7 Changing Presets
Colors under Preset keys are factory stored, default colors (both
static and dynamic). Default dynamic colors can only be changed, using
the Actilume Color Studio software (for this, refer to ‘Actilume Color
Studio’. Default static colors can easily be changed as follows:

During playback of a ‘Light Show’, press the ‘ ’ key when you
see a color you wish to store as preset color.
Press a Preset key within 2 seconds.
• The current color is now stored as a static color under the Preset key,

even when a color sequence was running. Storing stops the sequence.
• The light dims twice to confirm that the color is stored.

5.1.8 RC5 codes 
RC5 codes contain the information the remote control uses to send
information to the Actilume Color controller.
An RC5 code consits of a System code and a Command code.
For the various commands, the remote control supplied uses the
following codes.These codes can be used to program any other RC5
IR remote control.

Command System code Command code

ON 30 11

OFF 30 12

X 1/2 30 3

X 3 30 4

X 6 30 0

Dim Up 30 9

Dim Down 30 10

Hue + (clockwise) 30 14

Hue- (counter clockwise) 30 13

S(tatic) 30 5

D(ynamic) 30 6

Store 30 8

Preset 1 29 65

Preset 2 29 66

Preset 3 29 67

Preset 4 29 68

Preset 5 29 69

Preset 6 29 70

Preset 7 29 71

Preset 8 29 72

Preset 9 29 73

Preset 10 29 74

2

1

5.2 Operation via a DALI control system
• When installed in a DALI network, the Actilume Color system can

be operated via any DALI-based digital control system like:
- WattStopper;
- Leviton;
- etc.
However, it is recommended to use the system in combination
with Philips MultiDim.

• For detailed information on how to operate the system via a
DALI control system, refer to the User Manual that came with the
system.

5.3 Operation via a DMX control panel
• When installed in a DMX network, the Actilume Color system

can be operated via any DMX-based control panel like:
- LitePutter CX,-5 12 ch;
- KWL Lighting DXG 144 Din 230 144 ch;
- 4Track HQ Power VDPDMXC 145;
- etc.

• For detailed information on how to operate the system via a
DMX control panel, refer to the User Manual that came with the
control panel.
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Actilume Color Studio
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6 Actilume Color Studio

6.1 Introduction
Actilume Color Studio enables you to create, preview and upload
‘Light shows’ intended for Actilume Color system enabled fixtures.
There are three possible options for using Actilum Color Studio:
• Without connection to controllers and physical fixtures.

‘Light Shows’ can be created and stored on your computer’s
harddisk and e.g. saved on CD-ROM for further distrubution.
Previewing a ‘Light Show’ is done in the ‘Light Plan’ in the ‘View’
menu. For this refer to 10.3 ‘Previewing a Light Show’.

• With your computer connected to the controller(s) via a DALI
gateway (RS232 to DALI gateway). ‘Light Shows’ can now also be
uploaded to the controllers. For this refer to 12 ‘Uploading a Light
Show’.

• With your computer connected to both controller(s) and physical
fixture(s) via a DALI gateway (RS232 to DALI gateway). ‘Light
Shows’ can now also be previewed on the fixtures. For this refer to
10.3 ‘Previewing a Light Show’.

6.2 System requirements 
• Microsoft® Windows® XP or Vista;
• Pentium® III, 500 Mhz or equivalent;
• 128MB RAM and 100 MB free harddisk space;
• One free serial port and CD-ROM or DVD drive.

6.3 Connecting your computer to the Actilume Color
system

Connect your computer via an RS232 cord with the gateway.
Connect the gateway terminals DA- and DA+ with two wires
with the controller GP _DALI inputs.
• For connection, use cord types as described in Chapter 13

‘Data sheets’.
• Note that the gateway will not be mounted inside the fixture.

6.4 Installing the Actilume Color Studio software on your
computer

Place the installation CD-ROM in your computer’s / laptop’s CD-
ROM / DVD drive.

• After a couple of seconds the ‘Actilume Color Studio Setup Wizard’
screen appears.

• The Wizard will guide you through the installation process.

1

2

1

Click ‘Next’ to continue.
• The ‘Select Installation Folder’ screen appears.

Click ‘Browse’ to select a folder to install Actilume Color Studio
in. Click ‘OK’ to confirm.

• Click ‘Disk Cost . . .’ to display a list of drivers you can install to
as well as the available disk space.

Click ‘Next’.
• The ‘Confirm Installation’ screen appears.
Click ‘Next’.

• The ‘Actilume Color Studio Information’ screen appears.
Click ‘Next’ to start installation.

• Actilume Color Studio will now be installed in the selected folder.
• When installation was successful, the ‘Installation complete’ screen

appears.
Click ‘Close’ to exit the Wizard.7

6

5

4

3

2
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6.5 Terminology
Throughout this section, the following terminology is used:
• Fixture: representation of a physical fixture.
• Light Group: a grouping of multiple fixtures.
• Color Point: defines what color to show for what period of

time.The contained fade time specifies how long it should take to
fade from the previous color to the defined color and the
contained hold time specifies how long to keep showing the
defined color.

• Timeline: a series of ‘Color Points’ that lasts a certain amount of
time (playtime).The playtime equals the sum of the fade and hold
times of all ‘Color Points’ in the ‘Timeline’.

• Scene: a collection of ‘Timelines’, where each ‘Timeline’ is
assigned to a ‘Light Group’ The playtime of all ‘Timelines’ in a
‘Scene’ is equal, enabling synchronized behavior between the
configured fixtures.

• Sequence: represents the collection of ‘Timelines’ across ‘Scenes’
that are assigned to one specific ‘Light Group’.

• Light Show: the collection of all defined ‘Scenes’ and ‘Timelines’.

6.6 Menus and tools
• Double click the ‘Actilume Color Studio’ icon ‘ ’ in the folder

where you installed the application.
• The ‘Actilume Color Studio’ start screen appears.

• In the screen the following menus and tools are available when
working with Actilume Color Studio:

6.6.1 Menus

File
Main menu for ‘Light Show’  functionality.

New (Ctrl+N):
Creates a new ‘Light Show’.This includes one ‘Scene’, one ‘Sequence’,
one ‘Light Group’ and one fixture in the ‘Light Plan’.The default
‘Scene’ playtime can be set using the ‘Preferences’ window.

Open…(Ctrl+O):
Opens an existing ‘Light Show’ stored on your computer.
An ‘Open File Dialog’ is shown to select a file.

Close:
Closes the current ‘Light Show’.

Save (Ctrl+S):
Saves the current ‘Light Show’. If this ‘Light Show’ was not saved yet a
‘Save File’ dialog is shown. See also ‘Save As…’.

Save As…:
Saves the current ‘Light Show’ with the possibility to select a path and
file name.

Properties:
Opens the ‘Light Show Properties’ screen.You can fill in properties
such as ‘Title’, ‘Author’ and ‘Company’.

Exit:
Closes the current ‘Light Show’ and closes the application.

View
Main menu for viewing functionality.

Toolbox:
Shows the ‘Toolbox’. If the ‘Toolbox’ is already visible nothing happens.
The ‘Toolbox’ contains tools for adjusting colors.

Light Plan:
Shows the ‘Light Plan’.The ‘Light Plan’ is a visible representation of the
fixtures in the ‘Light Show’. If the ‘Light Plan’ is already visible nothing
happens.

Toolbars:
‘Toolbars’ contain shortcuts to a number of important functions.
This option toggles the visibility of the ‘Toolbars’. If the ‘Toolbars’ are
already visible they are hidden.

Statusbar:
Shows status information about the selected editing mode.

Zoom In (Ctrl+NUM+):
Increases the frame width of the current ‘Scene’, forcing the
‘Timelines’ to show ‘Color Points’ in a larger area.The time grid is
automatically recalculated and the time units are updated.
The maximum zoom factor is 800%.
If ‘Color Points’ are inserted or deleted, the ‘Timeline’ width remains
the same and the time is updated in order to keep the same zoom
factor.

Zoom Out (Ctrl+NUM-):
Decreases the frame width of the current ‘Scene’, forcing the
‘Timelines’ to show ‘Color Points’ in a smaller area.The time grid is
automatically recalculated and the time units are updated.
If the entire ‘Timeline’ is shown on a single screen it is not possible to
‘Zoom Out’ more. If ‘Color Points’ are inserted or deleted the
‘Timeline’ width remains the same and the time is updated in order
to keep the same zoom factor.
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Edit
Main menu for ‘Timeline’ editing The clipboard is maintained at
application level enabling cut / copy / paste actions across different
Scenes and Sequences.

Cut (Ctrl+X):
Cuts the selected ‘Color Point(s)’ and temporarily stores it / them on
the clipboard. If no ‘Color Point’ is selected, nothing happens.
It is possible to cut one or multiple adjacent ‘Color Points’.

Copy (Ctrl+C):
Copies the selected ‘Color Point(s)’ and temporarily stores it / them
on the clipboard. If no ‘Color Point’ is selected, nothing happens.
It is possible to copy one or multiple adjacent ‘Color Points’.

Paste (Ctrl+V):
Pastes the ‘Color Point(s)’ currently present on the clipboard
(e.g. from a previous cut or copy action). If a ‘Color Point’ is selected,
the clipboard’s content is pasted before the selected ‘Color Point’.
If no ‘Color Point’ is selected, the ‘Color Point(s)’ are pasted at the
beginning of the ‘Timeline’.After a paste operation the clipboard
remains filled, allowing multiple sequential paste actions.

Delete (Del):
Deletes the selected ‘Color Point(s)’. If no ‘Color Point’ is selected,
nothing happens. It is possible to delete one or multiple adjacent
‘Color Points’.After deletion all ‘Color Points’ on the right of the
deletion will shift left to fill the gap.

Light show 
Main menu for general ‘Light Show’ functionality.

Add New Scene:
Adds a ‘Scene’ to the current ‘Light Show’.The newly added ‘Scene’
will automatically have an equal number of ‘Timelines’ as the existing
‘Scenes’.

Remove Selected Scene:
Removes the current ‘Scene’ from the ‘Light Show’, including all
‘Timelines’ and ‘Color Points’.
It is not possible to have a ‘Light Show’ without any ‘Scenes’ so
removal of the last ‘Scene’ is not possible.

Add New Sequence…:
Adds a ‘Sequence’ to the current ‘Light Show’.
A ‘Sequence’ can only be added if a ‘Light Group’ is assigned to it.
A window to create a new ‘Light Group’ is shown when adding a
‘Sequence’. Here you can select between existing (unassigned) ‘Light
Groups ‘or create a new one.

Remove Selected Sequence:
Removes the current ‘Sequence’ from all ‘Scenes’.The coupled ‘Light
Group’ is unassigned, but not removed.

Light Group/Fixture Management…:
Management window for adding, editing and removing ‘Light Groups’
and fixtures for the current ‘Light Show’. Refer to 9 ‘Managing Light
Group and Fixtures’.

Upload…:
Opens a window to start uploading the current ‘Light Show’ to the
actual fixtures.

Preview
Main menu for previewing functionality.This menu is disabled when no
‘Sequences’ are present in the current ‘Light Show’.

Play:
Starts preview of the selected ‘Scene’.
If ‘Enable scene preview on controller’ is checked in the ‘Preferences’
window, the application will check the connection with the required
interface hardware and issues a warning if something is wrong.

Stop:
Stops preview of the playing ‘Scene’.

Jump To Start:
Stops the preview and rewinds to the beginning of the ‘Scene’.

Jump To End:
Stops the preview and jumps forward to the end of the ‘Scene’.

Speed Up (Ctrl+Up):
Multiplies the preview speed for the selected ‘Scene’ by a factor 2.
The speed can be set to a maximum of 64 x the original speed,
making every hour last approximately one minute.This enables a quick
impression of long and slow effects.

Speed Down (Ctrl+Down):
Divides the preview speed for the selected Scene by a factor 2.
The speed can be set to a minimum of 1/8 x the original speed,
making every second last 8 seconds.This enables previewing of short
and fast effects that are difficult to follow in real-time.

Palettes
Main menu for ‘Palette’ functionality.There are two kinds of ‘Palettes’
which are both located in the ‘Toolbox’ window.

Color Palette:
Submenu for general ‘Color Palette’ functionality.A ‘Color Palette’ is a
collection of preferred / used colors that enables you to create
consistency when reusing colors.

New:
Creates a new and empty ‘Color Palette’.This new ‘Color Palette’ has
no name and no colors in it. If a ‘Color Palette’ was already open,
it will be closed without saving it.
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Open…:
Shows an ‘Open File Dialog’ to enable you to select an existing
‘Color Palette’ file from your harddisk. If a ‘Color Palette’ was already
open, it will be closed without saving it.

Import…:
Shows an ‘Open File Dialog’ that enables you to select an existing
‘Color Palette’ file from disk.All colors from the selected ‘Color
Palette’ file are added to the already open ‘Color Palette’.
The imported file remains unchanged.

Save:
Saves the current ‘Color Palette’. If the ‘Palette’ was opened from
your harddisk or saved before, the existing file is updated silently. If
the ‘Palette’ was newly created, a ‘Save File Dialog’ appears to allow
the user to select a filename and folder.

Save As…
Shows a ‘Save File Dialog’ to enable you to select a filename and folder.

Effect Palette:
Submenu for general ‘Effect Palette’ functionality.An ‘Effect Palette’ is a
collection of ‘Effects’ that consist of multiple ‘Color Points’.
This ‘Palette’ enables you to save a piece of a ‘Timeline’ in order to
reuse it (in other ‘Light Shows’).

New:
Creates a new and empty ‘Effect Palette’.This new ‘Effect Palette’ has
no name and no ‘Effect’ in it. If an ‘Effect Palette’ was already open,
it will be closed without saving it.

Open…:
Shows an ‘Open File Dialog’ to enable you to select an existing ‘Effect
Palette’ file from your harddisk. If an ‘Effect Palette’ was already open,
it will be closed without saving it.

Import…:
Shows an ‘Open File Dialog’ to enable you to select an existing ‘Effect
Palette’ file from your harddisk.All effects from the selected ‘Effect
Palette’ file are added to the already open ‘Effect Palette’.The
imported file remains unchanged.

Save:
Saves the current ‘Effect Palette’. If the ‘Palette’ was opened from your
harddisk or saved before, the existing file is updated silently. If the
‘Palette ‘was newly created, a ‘Save File Dialog’ appears to enable you
to select a filename and folder.

Save As…:
Shows a ‘Save File Dialog’ to enable you to select a filename and
folder.

Tools
Offers functionality to select the editing mode and to change the
application preferences.

Draw Constant Color:
Selects ‘Draw Constant Color’ editing mode, which enables you to
insert constant colors in ‘Timelines’.

Draw Fade:
Selects ‘Draw Fade editing’ mode, which enables you to insert fade
transitions in ‘Timelines’.

Select Color Points:
Selects ‘Selection’ mode, which enables a user to select and edit
existing ‘Color Points’ in ‘Timelines’.

Preferences
Opens a window where some application preferences can be
configured.

Help
Main menu for ‘Help’.

Contents… (F1):
This is where all Actilume Color Studio help is located.
About Actilume Color Studio…:
Shows a window with the Company name and Version number.

6.6.2 Tools

The tools in the toolbar function as shortcuts to items in the various
menus.

- Add sequence.Also see ‘Light show’ menu.
- Delete selected sequence.Also see ‘Light show’ menu.
- Zoom in.Also see ‘View’ menu.
- Zoom out.Also see ‘View’ menu.
- Open color palette.Also see ‘Palettes’ menu.
- Save color palette.Also see ‘Palettes’ menu.
- Cut selection.Also see ‘Edit’ menu.
- Copy selection.Also see ‘Edit’ menu.
- Paste selection.Also see ‘Edit’ menu.
- New light show.Also see ‘File’ menu.
- Open light show.Also see ‘File’ menu.
- Save light show.Also see ‘File’ menu.
- Show toolbox.Also see ‘Tools’ menu.
- Show lightplan.Also see ‘View’ menu.
- Help.Also see ‘Help’ menu.
- Starts preview of the selected ‘Scene’.Also see ‘Preview’ menu.
- Stops preview of the playing ‘Scene’.Also see ‘Preview’ menu.

If playback was already stopped the ‘Timeline’ jumps to start.
- Stops the preview and rewinds to the beginning of the ‘Scene’.

Also see ‘Preview’ menu.
- Stops the preview and rewinds to the end of the ‘Scene’.

Also see ‘Preview’ menu.
- Speed up. Multiplies the preview speed for the selected ‘Scene’

by a factor 2. If another Scene is currently playing this is not
influenced because every Scene has its own preview speed
multiplication.The speed can be set to a maximum of 64x the
original speed, making every hour last approximately one minute.
This enables a quick impression of long and slow effects.|
Also see ‘Preview’ menu.

- Diminishes preview speed for the selected ‘Scene’ by a factor 2.
If another ‘Scene’ is currently playing this is not influenced
because every ‘Scene’ has its own preview speed multiplication.
The speed can be set to a minimum of 8x the original speed,
making every second last 8 seconds.This enables previewing of
short and fast effects that are difficult to follow are real time.
Also see ‘Preview’ menu.

- Speed indicator. Shows the preview speed multiplication factor
for the selected ‘Scene’. Every ‘Scene’ has its own multiplication
to enable different playback speeds for different ‘Scenes’.The
speed multiplication has a minimum of 8 times slower than
normal speed and a maximum of 64 times faster than normal
speed.

- Draw Constant Color.Also see ‘Tools’ menu.
- Draw Fade.Also see ‘Tools’ menu.
- Select color Points.Also see ‘Tools’ menu.
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7 Creating a ‘Light Show’

The ‘Actilume Color Studio’ application enables you to create ‘Light
Shows’ for ‘Actilume Color controller’ enabled fixtures.
A ‘Light Show’ defines the colors that all connected fixture will show
during a certain period.A ‘Light Show’ consists of one or more
‘Scenes’, where each ‘Scene’ defines a number of ‘Timelines’, all with
the same playtime.You can fill ‘Timelines’ by inserting ‘Color Points’.

Each ‘Timeline’ within a ‘Scene’ is assigned to a ‘Light Group’.
A ‘Light Group’ is a collection of fixture that should display colors
from the same ‘Timeline’.The number of ‘Timelines’ per ‘Scene’ is
equal for all defined ‘Scenes’.The collection of ‘Timelines’ for one
specific ‘Light Group’ across all defined ‘Scenes’ is called a ‘Sequence’.
You can add / remove ‘Scenes’ and ‘Sequences’ and the ‘Actilume
Color Studio’ application will create new ‘Timelines’ as required.

7.1 Quick Start
In this chapter we will describe basic programming of a ‘Lightshow’.
Detailed information on the various progamming steps and
possibilities can be found in the following sections.

Click the ‘Actilume Color Studio’ icon ‘ ’ in the folder where
you installed the application.
• The ‘Actilume Color Studio’ start screen appears.

Open a new, empty ‘Light Show’ screen.
• Click ‘ ’ in the toolbar or select ‘New’ in the ‘File’ menu

(‘CTRL’ + ‘N’).

• The default empty ‘Light Show’ screen appears.
• One ‘Scene’ with one empty ‘Timeline’ is displayed.This ‘Timeline’ is

connected to an empty ‘Light Group’.The default playtime of the
‘Timeline’ is 1 hour.

If you want to make a complete ‘Light Show’ with more than one
‘Scene’, you can now add ‘Scenes’. For details refer to 7.3 ‘Scenes’.
If you want to make a synchronized ensemble for more than one
fixture or ‘Light Group’ with different colors and fades, you can
add one or more ‘Sequences’ to the ‘Scene’. For details refer to
7.4 ‘Sequences’.
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Fill the ‘Timelines’ with colors and color fades. For details, refer to
7.5 ‘Drawing Constant Colors’, 7.6 ‘Drawing Color Fades’,
7.8 ‘Selecting and editing colors’ and 7.9 ‘Fine-tuning colors’.
• The first ‘Timelines’ from each ‘Scene’ will be loaded to the first ‘Light

Group’. Pressing Preset key 1 on the remote controll starts the first
‘Timeline’ of the first ‘Scene’ in the ‘Light Show’, Preset key 2 the
second, etc.To change this order or the default stored colors under
the Preset keys, refer to 5.1.7 ‘Changing Presets’.

To preview a ‘Light Show’ on screen, start preview playback.
For details, refer to 10 ‘Previewing a Light Show’. For playback
functionality, refer to 6.6.1 ‘Menus - Preview’ and 6.6.2 ‘Tools’.
To preview on physical connected fixtures:
• start ‘Discovery’ and assign the discovered addresses to the

fixtures. For details, refer to 9.3 ‘Discovery’;
• add discovered fixture to the desired ‘Light Group’;
• start the preview. For details, refer to 10 ‘Previewing a Light

Show’.
• The previewed ‘Timelines’ are not stored on the controller.

If you disconnect the computer, the content of the controller
memory remains unchanged.

To save the ‘Light Show’ (on harddisk, CD, etc.), use the ‘File’
menu. Refer to 6.6.1 ‘Menus - File’.

• If desired you can fill in ‘Light Show’ properties (title, author,
company, etc.). For this, refer to 7.6.1 ‘Menus - File’.
To upload the ‘Light Show’ to the connected controllers (fixtures),
use the ‘Upload Light Show’ functionality. For details, refer to 
11 ‘Uploading a ‘Light Show’.
• If you start uploading the new content to the connected controllers

(fixtures), the old content will be overwritten. ‘Undo’ is not possible.

7.2 Getting started
Click the ‘Actilume Color Studio’ icon ‘ ’ in the folder where
you installed the application.
• The ‘Actilume Color Studio’ start screen appears.

Open a new, empty ‘Light Show’ screen.
• Click ‘ ’ in the toolbar or select ‘New’ in the ‘File’ menu

(‘CTRL‘ + ‘N’).

• The default empty ‘Light Show’ screen appears.You can now create
your ‘Light Show’.
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7.3 Scenes
The default empty ‘Light Show’ contains only one ‘Scene’.The ‘Light
Show’ menu enables you to add or remove ‘Scenes’.

7.3.1 Adding ‘Scenes’ to a ‘Light Show’
Select ‘Add New Scene’ in the ‘Light Show’ menu.

• The ‘Scene’ will be added to the ‘Light Show’.
• Add more ‘Scenes’ in the same way.

Select ‘Save’ (Ctrl+S) in the ‘File’ menu to save your settings.

7.3.2 Configuring ‘Scenes’
Right click in the ‘Scene’ window.
Select ‘Scene Properties’ in the dialog box that appears.
• The ‘Scene property’ screen appears.
Enter ‘Scene Name’ and ‘Scene Playing Time’.
• Adjusting the playing time will extend all ‘Timelines’ in the ‘Scene’ as

required. Existing ‘Color Points’ in ‘Timelines’ are never lost when
specifying a shorter playtime.
If you attempt to set a playing time that is shorter than the already
filled ‘Timeline’, this is ignored and the ‘Timeline’ is cropped only 
(the trailing empty space is removed).

• If required, select a fade time for the scene under ‘End to begin
fade time’.
• This property determines time  to gradually fade from the last colors

in the ‘Timelines’ to the begin colors when the end of a ‘Scene’ is
reached and playbacks loops back to the beginning of the Scene.
This setting only affects the ‘Light Show’ data that is uploaded to the
‘Actilume Color controller’.The configured fade time is not visible in
the ‘Timeline’ or during preview.

Click ‘OK’ to save the new properties.

• ‘Scene’ properties can be changed at all times by right clicking in
the ‘Scene’ window and selecting ‘Scene Properties’.
Select ‘Save’ (Ctrl+S) in the ‘File’ menu to save your settings.

7.3.3 Removing ‘Scenes’ from a ‘Light Show’
Select the ‘Scene’ you wish to delete by clicking it’s tab in the
‘Light Show’ window.
• The ‘Scene’ will be highlighted.
Select ‘Remove Selected Scene’ in the ‘Light Show’ menu.

Click ‘Yes’ in the dialog box thay appears.
• The ‘Scene’ is deleted from the ‘Light show’.
Select ‘Save’ (Ctrl+S) in the ‘File’ menu to save your settings.4
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7.4 Sequences
The default empty ‘Light Show’ contains one ‘Sequence’ attached to a
default ‘Light Group’.A ‘Sequence’ must always be assigned to a ‘Light
Group’. Hence, when adding a ‘Sequence’, a ‘Light Group’ must be
selected and / or created when needed.The ‘Light Show’ menu
enables you to add or remove ‘Sequences’, create ‘Light Groups’ and
assign ‘Sequences’ to ‘Light Groups’.

7.4.1 Adding ‘Sequences’ to a ‘Light Show’
Click ‘ ’ in the toolbar or select ‘Add New Sequence’ in the
‘Light Show’ menu.

• The ‘Add New Sequence’ screen appears.
Select the ‘Light Group’ you wish to assign the sequence to.
Confirm by clicking ‘OK’.

• If no ‘Light Groups’ were created yet, click ‘Create New Light
Group’, enter the ‘Light Group’ name and confirm by clicking
‘OK’.

7.4.2 Configuring ‘Sequences’
Right click in the ‘Light Group’ window of the ‘Sequence’ you wish
to delete.
Select ‘Sequence Properties’ in the dialog box that appears.
• The ‘Sequence property’ screen appears.
You can now assign the ‘Sequence’ to another ‘Light Group’ if
desired.
Click ‘OK’ to save the new properties.

• ‘Sequence’ properties can be changed at all times by right clicking
in the ‘Light Group’ window of the ‘Sequence’ and selecting
‘Sequence Properties’.
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7.4.3 Removing ‘Sequences’ from a ‘Light Show’
Select the ‘Sequence’ you wish to delete by right clicking in the
‘Light Show’ window.
• The ‘Sequence’ will be highlighted.
Click ‘ ’ in the tool bar or select ‘Remove Selected Sequence’ in
the ‘Light Show’ menu.

Click ‘Yes’ in the dialog box that appears.
• The ‘Sequence’ will be deleted from the ‘Light show’.
Select ‘Save’ (Ctrl+S) in the ‘File’ menu to save your settings.

7.5 Drawing Constant Colors
Constant color intervals can be inserted by dragging on the ‘Timeline’.
The fixture assigned to the ‘Timeline’ will hold the color for the
specified amount of time.

Click ‘ ’ in the tool bar or select ‘Toolbox’ in the ‘View’ menu.

• A color wheel appears in the ‘Toolbox’ window.

Click on the desired ‘Light Group’.
• The ‘Light Group’ will be highlighted.
Click ‘ ’ in the tool bar or select ‘Draw Constant Color’ in the
‘Tools’ menu.

Select a color in the color wheel by clicking on it.
• Use the dim slider or the ‘HSB’ (Hue, Saturation, Brightness)

and ‘RGB’ (Red, Green Blue) values to select an exact color.
Insert the color into the ‘Timeline’ by dragging the cursor (left or
right) along the ‘Timeline’.

• The first ‘Color Point’ is positioned at the start of the ‘Timeline’.
• When dragging along the empty space of the ‘Timeline’, the new

‘Color Point’ is appended at the end of the existing ‘Color Points’ in the
‘Timeline’.

• When dragging over an already filled part of the ‘Timeline’, the new
‘Color Point’ is inserted between the existing ‘Color Points’.

Select ‘Save’ (Ctrl+S) in the ‘File’ menu to save your settings.6
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7.6 Drawing Color Fades
‘Fades’ are gradual transitions from one color to another color.
‘Fades’ can be inserted at the start or end of the ‘Timeline’ or in
between ‘Color Points’.

Click ‘ ’ in the tool bar or select ‘Draw Fade’ in the ‘Tools’ menu.

Insert the ‘Fade’ by dragging the cursor (left or right) at the
‘Timeline’ in the selected color.

• When dragging in the trailing empty space of the ‘Timeline’, the new
‘Color Point’ is appended at the end of the existing ‘Color Points’ in the
‘Timeline’ (or at the start if it is the first ‘Color Point’).

• When dragging over existing ‘Color Points’ in the ‘Timeline’, the new
‘Color Point’ is inserted in between the existing ‘Color Points’.

• When inserting a ‘Fade point’, it gets assigned the color from the
‘Color Point’ that lies to the right of the ‘Fade point’. A ‘Fade Color
Point’ always starts fading from the color of the ‘Color Point’ that lies
to the left of it.

• When a sequence starts with a fading, you will avoid a color
interruption when you would change over from one sequence to
another.The Actilume Color calculates the fading from the displayed
color to the new sequence.

7.7 Timeline Auto-Extending
• The empty trailing space at the end of a ‘Timeline’ is automatically

extended when the ‘Timeline’ is almost full.
Therefore you can always add new ‘Color Points’ at the end of the
‘Timeline’. However, the maximum playing time of a ‘Timeline is
twenty four hours. If you try to exceed this time, the following
message will appear:

• Once the ‘Timeline’ is more or less finished, the last trailing empty
space can be selected and deleted. For this, refer to 7.8 ‘Selecting
and editing colors’.

• Re-adding the empty trailing space at the end of the ‘Timeline’ can
be achieved by adjusting the ‘Scene’ playtime in the ‘Scene’
properties. For this, refer to 7.3.2 ‘Configuring Scenes’.

7.8 Selecting and editing colors
One or more adjacent ‘Color Points’ can be selected and edited.

7.8.1 Selecting ‘Color Points’
Click ‘ ’ in the tool bar or select ‘Select Color Point’ in the
‘Tools’ menu.

Select the ‘Color Point’ you wish to edit.
To select more ‘Color Points’, drag the cursor (left or right) along
the ‘Timelines’.
• The selected ‘Color Points’ is highlighted.
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7.8.2 Clipboard functionality
Right click in a selected area.
• The following menu appears.

• The following options are available for editing colors:

Cut, Copy, Paste, Delete
Selected ‘Color Points’ can be cut, copied, pasted and / or deleted.
The clipboard works application-wide and hence can be used to copy
‘Color Points’ across different ‘Scenes’ and ‘Sequences’.
‘Cut’, ‘Copy’, ‘Paste’ and ‘Delete’ functionality is also available from the
‘Edit’ menu. Refer to 6.6.1.

Add to Color Palette
Adds the selected color to the ‘Color Palette’ in the ‘Toolbox’
window.

Add to Effect Palette
Adds the selected color to the ‘Effect Palette’ in the ‘Toolbox’ window.

Color point Properties
Refer to 7.8.3. ‘Color Point Preperties’.

Sequence Properties
Refer to 7.4.2. ‘Configuring Sequences’.

Scene Properties
Refer to 7.3.2. ‘Configuring Scenes’.

7.8.3 Color Point Properties
Right click in a selected area.
• The following menu appears.

Select ‘Color Point Properties’.
• The ‘Color Point Properties’ screen appears.

• The following properties of a single ‘Color Point’ can now be adjusted:

Color
RGB values: the numerical Red, Green and Blue color values.
Duration
Fade time: the duration time to gradually fade from the color of the

previousn ‘Color Point’ to the current ‘Color Point’ color.
Hold time: the duration time to gradually fade from the color of the

previous ‘Color Point’ to show the ‘Color Point’s’ constant
color. ‘Fade’ and ‘Hold’ times are limited to a set of specific
discrete times.This is due to a limitation in the communication
protocol with the ‘Actilume Color controller’.

2
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Position
Index of the ‘Color Point’ in the ‘Timeline’.

Click ‘OK’ to save your settings.

7.9 Fine-tuning colors
Once ‘Color Points’ are inserted in the ‘Timeline’, the color can be
fine-tuned to exactly match your own personal preference.
Fine-tuning can be done for one ‘Color Point’ at a time.

Click ‘ ’ in the tool bar or select ‘Select Color Point’ in the
‘Tools’ menu.

Select the ‘Color Point’ you wish to fine-tune.
• The selected ‘Color Point’ will be highlighted.
Select a color in the ‘Color Wheel’ by clicking on it.
Use the dim slider or the ‘HSB’ (Hue, Saturation, Brightness) and
‘RGB’ (Red, Green, Blue) values to select an exact color.
• The selected color will immediately be updated in the ‘Timeline’.

Note:
An inserted fade ‘Color Point’ with a hold time of 0 that is
followed by a hold ‘Color Point’ with a fade time of 0 and which
has the exact same color, has specific fine-tuning behavior.
When fine-tuning one of these two ‘Color Points’, the other
adjacent ‘Color Point’ is fine-tuned with the same color as well.
This is to keep the color of these two ‘Color Points’ in sync, since
in most cases such a sequence of colors should be kept intact.

7.10 Using Color Palettes
The ‘Color Palette’ helps reusing (favorite) colors.A color can be
saved to the palette manually or automatically when inserting ‘Color
Points’ on a ‘Timeline’.All colors on the ‘Palette’ are displayed as a
colored rectangle. Selecting one of these rectangles sets the active
color. Depending on the active mode a selected ‘Color Point’ is
fine-tuned (‘Select mode’) or the draw color is set (‘Draw Constant
Color mode’).

7.10.1 Opening a Color Palette
Make sure the ‘Toolbox’ window is open.
Select ‘Color Palette’ in the ‘Palettes menu.

Then select ‘Open’ in the ‘Color Palette’ menu that appears.
• You can also click ‘ ’ in the ‘Toolbar’ to open the ‘Palettes’ menu.

Select the desired ‘Color Palette’ from the list that appears and
click ‘Open’.

• The selected ‘Color Palette’ appears in the ‘Toolbox’ window and can
be used for creating a ‘Light Show’.
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7.10.2 Creating a new Color Palette
Make sure the ‘Toolbox’ window is open.
Select ‘New’ in the ‘Color Palette’ menu.
• An empty ‘Color Palette’ appears in the ‘Toolbox’ window.

Select ‘Import’ in the ‘Color‘Palette’ menu.
• The ‘Import’ screen appears.
Select a ‘Color Palette’ from the list and click ‘Open’.
• The colors from the selected ‘Color Palette’ are assigned to the new

created ‘Color Palette’ in the ‘Toolbox’ window.
• Select colors from other ‘Color Palettes’ in the same way.

Click ‘ ’ in the toolbar or select ‘Save’ or ‘Save as’ in the ‘Color
Palette’ menu.
Enter a name for the new created ‘Color Palette’ in the window
that appears. Click ‘Save’.
• The ‘Color Palette’ is now added to the list of ‘Color Palettes’.

Note:
Right clicking in the ‘Toolbox’ window, when a ‘Color Palette’ is
opened, will directly open the ‘Color Palette’ menu in the
‘Toolbox’ window.

7.10.3 Deleting colors from a Color Palette
In the ‘Color Palette’, right click the color you wish to delete.
Select ‘Delete’ in the window that appears.
• The color is now deleted from the ‘Color Palette’.

• Delete other colors in the same way.
Click ‘ ’ in the toolbar or select ‘Save’ to save changes.

7.10.4 Clearing an entire Color Palette
In the ‘Color Palette’, right click on a color or anywhere else in
the ‘Color Palette’.
Select ‘Clear Color Palette’ in the window that appears.
• The ‘Color Palette’ is now cleared from the list of ‘Color Palettes’.
Click ‘ ’ in the toolbar or select ‘Save’ to save changes.

7.11 Using Effect Palettes
The ‘Effect Palette’ helps reusing (favorite) effects, which consist of
two or more ‘Color Points’.An ‘Effect’ can be saved to the palette by
selecting multiple ‘Color Points’ and right clicking on the selection.
The effects are arranged in a list, selecting one of these items enables
you to draw the selected effect on the timeline.
The total duration of an inserted effect can only be manipulated when
inserting it. Once the mouse is released and the effect is inserted it is
not possible to change the duration of the entire effect.

7.11.1 Opening an Effect Palette
Make sure the ‘Toolbox’ window is open.
Select ‘Effect Palette’ in the ‘Palettes menu.

Then select ‘Open’ in the ‘Effect Palette’ menu that appears.
Select the desired ‘Effect Palette’ from the list that appears and
click ‘Open’.
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• The selected ‘Effect Palette’ appears in the ‘Toolbox’ window and can
be used for creating a ‘Light Show’.

7.11.2 Creating a new Effect Palette
Make sure the ‘Toolbox’ window is open.
Select ‘New’ in the ‘Effect Palette’ menu.
• An empty ‘Effect Palette’ appears in the ‘Toolbox’ window.

Select ‘Import’ in the ‘Effect Palette’ menu.
• The ‘Import’ screen appears.
Select an ‘Effect Palette’ from the list and click ‘Open’.
• The effects from the selected ‘Effect Palette’ are assigned to the new

created ‘Effect Palette’ in the ‘Toolbox’ window.
• Select effects from other ‘Effects Palettes’ in the same way.

Select ‘Save’ or ‘Save as’ in the ‘Effect Palette’ menu.
Enter a name for the new created ‘Effect Palette’ in the window
that appears. Click ‘Save’.
• The ‘Effect Palette’ is now added to the list of ‘Effect Palettes’.

Note:
Right clicking in the ‘Toolbox’ window, when an ‘Effect Palette’ is
opened, directly opens the ‘Effect Palette’ menu in the ‘Toolbox’
window.

7.11.3 Renaming effects from an Effect Palette
In the ‘Effect Palette’, right click the effect you wish to rename.
Select ‘Rename’ in the window that appears.
Enter a new name.
Select ‘Save’ to save changes.

7.11.4 Deleting effects from an Effect Palette
In the ‘Effect Palette’, right click the effect you wish to delete.
Select ‘Delete’ in the window that appears.
• The effect will now be deleted from the ‘Effect Palette’.

• Delete other effects in the same way.
Select ‘Save’ to save changes.

7.11.5 Clearing an entire Effect Palette
In the ‘Effect Palette’, right click on an effect.
Select ‘Clear Effect Palette’ in the window that appears.
• The ‘Effect Palette’ is now cleared from the list of ‘Effect Palettes’.
Select ‘Save’ to save changes.3
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8 Preferences

The ‘Preferences’ window in the ‘Tools’ menu shows the application
settings.These settings are divided into three groups:
- ‘Controller’ settings;
- ‘Timeline editing’ settings;
- ‘Preview’ settings.

Select ‘Preferences’ in the ‘Tools’ menu.

• The ‘Preferences’ window appears.

1 Controller
Enables adjustment of controller settings.

Com Port
Defines the COM port (serial port or RS-232 port) to which the
Gateway is connected.When the window is opened the list of
COM ports is refreshed, showing only the available ports.
When the COM port is changed, the application will try to
connect to the Gateway and will display an error if this fails.

Enable ‘Scene’ preview on controller
If this option is enabled the ‘Scene’ preview will be shown in the
‘Light Plan’ and on the connected fixtures. Enabling this option
would require the fixture to be assigned an ‘Address’, and thereby
represent a physical fixture. Refer to 10 ‘Managing Light Groups
and Fixtures’ for more information about fixture and ‘Addresses’.
Disabling this option ignores the connected fixture and only
previews the ‘Scene’ on the ‘Light Plan’.

Enable Color Picker preview on controller
If this option is enabled, the selected color is broadcast to all
connected fixtures.This is done when selecting a color using the
‘Color Picker’ but also when using the ‘Color Palette’ and / or 
fine-tuning a ‘Color Point’.

2 Timeline Editing
Enables adjustment of ‘Timeline Editing’ settings.

Default ‘Scene’ playtime
Defines the default ‘Scene’ playtime when adding a ‘Scene’ to the
‘Light Show’.When a new ‘Light Show’ is created, this will also
create a new empty ‘Scene’ with this default ‘Scene’ playtime.

Automatically add inserted colors to the ‘Color Palette’
Enables the application to automatically add all newly inserted
colors to a ‘Color Palette’.
Automatic addition of colors can be useful when using the same
colors in a ‘Light Show’, but could also cause a large number of
undesired colors, added to the ‘Palette’ making it hard to use.
Adding colors to the ‘Color Palette’ can always be done manually
by selecting one or more ‘Color Point(s)’ in the ‘Timeline’ and
using the right click menu item ‘Add Colors to Palette’.

1

3 Preview
Enables adjustment of ‘Previewing’ settings.

Monitor Type
Enables you to select the monitor type on which the application is
currently running. Setting the correct monitor type is an input for
the color of the fixtures in the ‘Light Plan’.This color is only an
indication for the actual color on the fixtures because the
brightness of the screen cannot be taken into account. If this
setting is not set to the correct monitor type, then the colors in
the ‘Light Plan’ will give a slightly less accurate color preview.

Enable Scene preview looping
Defines if a ‘Scene’ loops when previewing it. If this option is
enabled, then the preview will automatically restart the ‘Scene’
from the beginning when finished. If this option is disabled, then
the ‘Scene’ will restart at the beginning and stop playback when
finished.

Make the desired adjustments and click ‘OK’ to save your settings.2
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9 Managing Light Groups and Fixtures

In order to preview or load the created ‘Timeline(s)’, a connection
has to be made to the fixture network. Each ‘Timeline’ in the
‘Scene / Light Show’ is connected to exactly one ‘Light Group’.
When previewed and programmed, the actual characteristics of the
fixture are taken into account (realistic preview on screen).
If the exact fixture is still unknown, the creation process can still be
finished and the actual connection and uploading can be done
afterwards or in another session. It is enough to connect each
‘Timeline’ to an empty ‘Light Group’, while the actual fixture
characteristics can be filled in later. Creation can then take place, and
the ‘Light show’ can be saved.
Adding, editing and deleting ‘Light Groups’ and fixtures is done in the
‘Light Group / Fixture Management’ screen.

Select ‘Light Group / Fixture Management’ in the ‘Light Show’ menu.

• The ‘Light Group / Fixture Management’ screen appears.

9.1 Light Groups
A Light Group is a collection of 0 or more fixtures that allows a ‘Light
Show’ to be designed without actual knowledge about the
(physical) fixture network.A ‘Light Group’ is hard coupled to 0 or 1
‘Sequence’.A ‘Sequence’ is always coupled to a single ‘Light Group’.
If no unassigned ‘Groups’ are available, when adding a ‘Sequence’, a
new ‘Group’ has to be created.

9.1.1 Adding Light Groups
Click ‘Add’ in the ‘Light Group / Fixture Management’ screen.
• The ‘Add New Light Group’ screen appears.
Enter the name for the new ‘Light Group’.
It is not allowed to have duplicate names in one ‘Light Show’.
Select a group ‘Type’ (if possible). Default group type is ‘Color’.
Click ‘OK’ to save the new ‘Light Group’.

• The new ‘Light Group’ is not assigned and ready for coupling to
a new or existing ‘Sequence’. For this refer to 7.4.2 ‘Configuring
Sequences’.
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9.1.2 Editing ‘Light Group’ settings
‘Name’ and ‘Type Group’ of a ‘Light Show’ can be changed.
If the ‘Light Group’ is coupled to a ‘Sequence’ it is not possible to
change the ‘Type’, only the ‘Name’. If the ‘Type’ of an existing ‘Light
Group’ needs to be altered, you should assign the ‘Sequence’ to a
alternative ‘Light Group’ and then edit the type of the unassigned
‘Group’. ‘Light Group’ names are free of choice, but no duplicate
names are allowed within a ‘Light Show’.

Click ‘Edit’ in the ‘Light Group / Fixture Management’ screen.
• The ‘Edit’ screen appears.
Enter the new name for the ‘Light Group’.
Select a group ‘Type’ (if possible).
Click ‘OK’ to save your settings.

• The new ‘Light Group’ is not assigned and ready for coupling to
a new or existing ‘Sequence’. For this refer to 7.4.2 ‘Configuring
Sequences’.

9.1.3 Removing ‘Light Groups’
• A ‘Light Group’ cannot be removed if it is coupled with a

‘Sequence’. In this case an ‘Error’ message will be shown.

• In order to remove this particular ‘Light Show’ the ‘Sequence’ must
be reassigned to an alternative ‘Light Group’ before continuing
removal. For this refer to 7.4.2 ‘Configuring Sequences’.

• If the ‘Light Group(s)’ that is (are) to be removed hold(s) one or
more fixtures, you will be asked for confirmation. If you continue,
the assigned fixtures are unassigned and the ‘Light Group’ will be
removed.

Select the ‘Light Group’ you wish to remove in the ‘Light Group /
fixture Management’ screen.
Click ‘Remove’.
• The ‘Remove Light Group?’ screen appears.
Click ‘Yes’.

• A series of checks will now be performed and the ‘Light Group’ will be
removed from the ‘Light Show’.

9.2 Fixtures
A fixture can be coupled to 0 or 1 ‘Light Groups’, while a ‘Light
Group’ can hold 0 or more fixtures.This way a single ‘Sequence’
(coupled to 1 ‘Light Group’) can be designed for multiple fixtures.
A fixture can either be a simulated fixture that only exists on the
computer (‘Light Plan’), or it is a fixture that is physically in the
targeted space.The only thing that makes a fixture a simulated one is
the lack of a ‘Short Address’.A fixtures’ ‘Short Address’ is a shortcut
to a physical fixture in the DALI network. Simulated fixtures allow you
to preview the ‘Light Show’ without knowledge of the actual space /
network it is designed for.Assigning simulated fixtures to physical
‘Addresses’ can be done using ‘Discovery’. For this, refer to 
9.3 ‘Discovery’.

3

2

1

4

3

2

1



27Managing Light Groups and Fixtures

9.2.2 Editing fixture settings
Select the fixture you wish to edit in the ‘Light Group / Fixture
Management’ screen.
Click ‘Edit’.
• The ‘Edit’ screen appears.

• Change ‘Name’, ‘Type’ and ‘Light Group’ settings as described in
8.2.1 ‘Adding Fixtures’.

• Click ‘Identify’ to see which fixture is coupled to the selected
‘Short Address’.

• Change ‘Fixture Properties’ as described in 9.2.1 ‘Adding Fixtures’.
Click ‘OK’ to save your settings.

Click ‘OK’ to exit ‘Fixture Properties’ settings.
Click ‘Close’ to exit ‘Light Group / Fixture Management’.

9.2.3 Removing fixtures
Select the fixture you wish to remove in the ‘Light Group /
Fixture Management’ screen.
Click ‘Remove’.
• The ‘Remove Fixture?’ screen appears.
Click ‘Yes’.

• The selected fixture will be removed from the ‘Light Show’.
Click ‘OK’ to exit ‘Fixture Properties’ settings.
Click ‘Close’ to exit ‘Light Group / Fixture Management’.

Note:
If the removed fixture was assigned a ‘Short Address’, you can
now couple this ‘Address’ to a different fixture.

9.2.4 Updating fixture properties
Use this functionality to update the physical fixture properties with
the properties set on your computer.This is required for factory
‘virgin’ fixtures that have no properties at all, altered fixtures and
when old age has influenced the color.
It is not possible to update properties of a simulated fixture, as it
does not physically exist.

In the ‘Light Group / Fixture Management’ screen, select the fixture
you wish to updat properties for.
Click ‘Update’.
Click ‘Start’ in the screen that appears.

• The ‘Overwrite fixture properties?’ screen appears.
Click ‘Yes’ to start the update.4
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9.2.1 Adding Fixtures

Click ‘Add’ in the ‘Light Group / Fixture Management’ screen.
• The ‘Add New fixture’ screen appears.
Enter the name for the new fixture.
It is not allowed to have duplicate names in one ‘Light Show’.
Select a ‘Fixture Type’ (if possible). Default ‘Fixture Type’ is ‘Color’.
Click ‘OK’ to save the new ‘Light Group’.

• If desired, select a ‘Light Group’ to assign the fixture to.
• The new fixture is a simulated one as no ‘Address’ is set by

default. Use ‘Discovery’ to fill the Address combo box. For this
refer to 9.3 ‘Discovery.

Manually setting fixture properties.
Enter ‘Min Dimlevel’ percentage (physical fixtures’ lamp driver
capacities).
Click ‘Edit’.
• The ‘Edit Primary’ screen appears.
Enter ‘Primary’ values (‘Color Point’, of individual lamps inside
physical fixture).
Click ‘OK’ to confirm.

Click ‘OK’ to exit ‘Fixture Properties’ settings.
Click ‘Close’ to exit ‘Light Group / Fixture Management’.

Importing fixture properties from database
Click ‘Database’.
• The ‘Fixture type’ screen appears.
Select the desired ‘Fixture type’ for the new fixture and click ‘OK’
to confirm.

• The properties of the selected ‘Fixture type’ will be assigned to the
new fixture.

Click ‘OK’ to exit ‘Fixture Properties’ settings.
Click ‘Close’ to exit ‘Light Group / Fixture Management’.4
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• A progress bar indicates the update progress.

• When the update was successful, the ‘Fixture updated’ screen
appears.

Click ‘OK’ to save the new properties.

Click ‘Close’ in the the ‘Light Group / Fixture Management’
screento exit Light Group / Fixture Management.

9.3 Discovery
Physical fixtures can only be addressed using their ‘Short Addresses’.
Discovery is used to get these ‘Short Addresses’ that can then be
assigned to physical fixtures in the network.
The fixture is then updated from simulated fixture to physical fixture.

The discovery process is bound to the functionality of the DALI
gateway (RS232 to DALI gateway).This ‘Gateway’ has an internal
coupling between physical fixtures and their assigned ‘Short
Addresses’.

Note:
If a ‘Light Show’ is saved to your harddisk the ‘Short Address’ is
also saved but, most likely, will not be valid by the time the ‘Light
Show’ is opened again.
An invalid address probably links no longer to a physical fixture. It
might even link to a different fixture. It is therefore advised to run
‘Discovery’ frequently (certainly when the network has changed)
in order to keep a valid list of ‘Short Addresses’ and to prevent
faulty preview, upload or update of properties.

9.3.1 Discovering fixtures
Make sure your computer is connected to at least the controller.
For this refer to 6.3 ‘Connecting your computer to the Actilume
Color system’.
Select ‘Light Group / Fixture Management’ in the ‘Light Show’
menu.

Click ‘Discover...’ in the ‘Light Group / Fixture Management’
screen.

• The ‘Discover Fixtures’ screen appears.
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Discover all Fixtures
Click ‘Start’.

• Before the actual discovery process starts all fixtures are cleared from
their ‘Short Address’.The following warning is shown to verify this action.

Click ‘Yes’ to start the discovery process.

• ‘Discovery’ now starts looking for ‘Short Addresses’ that are already
coupled to physical fixtures in the network.
The ‘Find All’ discovery process will rebuild the ‘Gateway’s’ internal
look-up table with physical ‘Addresses’ and coupled ‘Short Addresses’.
The found / assigned ‘Short Addresses’ are stored in a list and every
‘Address’ can be assigned to 0 or 1 fixture.

• A progress bar indicates the discovery progress.

Once started the process cannot be cancelled because this would
lead to undefined behavior concerning ‘Short Addresses’ in the DALI
network.

Only discover new Fixtures
Check the box before ‘Only discover new fixtures’.
Click ‘Start’ to start the discovery process.

• ‘Discovery’ now starts searching the DALI network for new fixtures
and assigns them a ‘Short Address’.

• The existing ‘Short Addresses’ in the ‘Gateway’ and in the ‘Light Show’
are remained.

• ‘Discovery’ will look for new fixtures but does not validate existing
‘Short Addresses’. Use the ‘Find All’ mode to ensure correct ‘Short
Addresses’.

9.3.2 Assigning ‘Short Addresses’ to fixtures
When the ‘Discovery’ process is finished one of the following screens
appears:

Click ‘OK’ to exit ‘Discovery’.
Select ‘Light Group / Fixture Management’ in the ‘Light Show’
menu.
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Select the fixture you wish to assign a ‘Short Address’ to and click
‘Edit’.

• The ‘Edit Fixture’ screen appears.
Select an address in the ‘Address’ box.

Click ‘Identify’ to check if the address is assigned to the correct
fixture.
• The light in the fixture with the new address dims.
Click ‘OK’ to save your settings.
Click ‘Close’ in the ‘Light Group / Fixture Management’ screen to
exit ‘Light Group / Fixture Management’.
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10 Previewing a Light Show

On the ‘Light Plan’ in the ‘View’ menu you can preview a ‘Light Show’
to get an impression of how the ‘Light Show’ looks when it is
uploaded to the physical fixtures.
If your computer is connected to the fixtures via a DALI gateway
(RS232 to DALI gateway) and the fixtures are assigned ‘Short
Addresses’ it is possible to preview the ‘Light Show’ on the actual
fixtures without uploading data to the fixtures.

Note:
Because no data are uploaded to the fixtures yet, all colors are
‘streamed’ via the DALI gateway to the individual fixtures using
DALI communication. DALI is a protocol not intended for fast
data streams.When previewing a ‘Scene’ every color is send to
the designated fixture, pushing the limit of the maximum DALI
communication speed. Especially when more fixtures are used in
that particular ‘Scene’ or when fast color transitions are used,
DALI will not keep up with the requested color update calls.
As a result of this limitation simultaneous color transitions will
occur closely after each other and fading will be less smooth as all
intermediate colors must be send over the network.

10.1 Light Plan
• A ‘Light Plan’ is a visual representation of all fixtures in the ‘Light

Show’.A fixture is shown as a rectangle with the fixture name and
‘Light Group’ as a label: e.g. ‘Fixture1 (Group1)’.

If the ‘Fixture Properties’ are imported from the ‘Fixture
Database’, the ‘Device Type’ is also shown in the rectangle: e.g.
’TL5 Color 14W (3%)’.Also refer to 9.2.2 ‘Editing Fixture
settings’.

• All fixtures in the ‘Light Plan’ can either be simulated or represent
a physical fixture in the DALI network.The difference between
these types is the presence / absence of a ‘Short Address’.
Simulated fixtures only exist on the computer and can later on be
coupled to an assigned ‘Short Address’ what makes them
represent a physical fixture.

• Fixtures can be coupled to a ‘Light Group’ or be unassigned.
If the fixture is coupled to a ‘Light Group’, it depends on the ‘Light
Group’ if it is also coupled to a ‘Sequence’. If the ‘Light Group’ is
coupled to a ‘Sequence’ the rectangle will change color accoring
to the corresponding ‘Time’ Line (‘Scene’ and ‘Sequence’)’.

• ‘Light Groups’ without any fixtures assigned are not shown in the
‘Light Plan’.
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10.2 Color Display

If the fixture in the ‘Light Plan’ is assigned to a ‘Light Group’ and this
‘Light Group’ is coupled to a ‘Sequence’ then the rectangle will change
color depending on the ‘Sequence’. If the ‘Sequence’ has ‘Color Points’
and the needle is on one of these colors it will indicate how the
‘Color Point’ will appear on that particular fixture.

Deviation from Time Line color 
The rectangle color is not a copy of the ‘Color Point’s’ color in the
‘Time Line’.The individual fixture properties cause this color to differ.
If the physical fixture has a very weak red lamp the deep red color
from the ‘Time Line’ will not be achieved on that fixture.The ‘Light
Plan’ gives an indication on how the actual light and color will appear
on the physical fixture. It is not possible to dim down the light
intensity for (parts of) the monitor so it can never be a perfect
match.
If multiple (different) fixtures are assigned to the same ‘Light Group’
(and ‘Sequence’) it is possible that they all show different colors for
the same ‘Color Point’, just like ‘Red’ can be different on fixture 
A and B.

10.3 Previewing a Light Show
Make sure the correct COM port (serial port or RS-232 port) on
your computer is selected and that the ‘Enable Scene preview on
controller’ and ‘Enable Color Picker preview on controller’
options (under ‘Preferences’ in the ‘Tools’ menu) are enabled. For
this refer to 8 ‘Preferences’.

Select ‘Open’ in the ‘File’ menu and select the ‘Light Show’ you
wish to preview from the list that appears.
• The selected ‘Light Show’ will be displayed.
Click ‘ ’ in the toolbar (right hand side of the screen) or select
‘Play’ in the Preview’ menu to start the preview.
• The selected ‘Light Show’ will start playing.

• Playback functionality can be controlled via the ‘Preview’ menu or
via the ‘Playback’ buttons in the toolbar (right hand side of the
screen). For an overview of button functions refer to 
6.6.1 ‘Menus’ and 6.6.2 ‘Tools’.
• The speed indicator (bottom left of the screen) shows the preview

speed multiplication factor for the selected ‘Scene’. Every ‘Scene’ has
its own multiplication to allow different playback speeds for 
different ‘Scenes’.The speed multiplication has a minimum of 8 times
slower than normal speed and a maximum of 64 times faster than
the normal speed.
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Click ‘ ’ in the toolbar or select ‘Light Plan’ in the ‘View’ menu.

• The ‘Light Plan’ appears in the lower part of the ‘Light Show’ screen.
All fixtures in the ‘Light Show’ are displayed.

• The progress bar in the ‘Light Plan’ indicates the time process.
When preview is playing or when the needle is manually moved the
progress bar will reflect the changes. If ‘Color Points’ are added or
removed the new maximum value is set to ensure 50% in the
progress bar matches 50% of the playtime.
The time indication is primarily used when preview is playing and the
‘Light Plan’ is rather large (on top of the ‘Time Lines’ with the
needle). It is not possible to influence the progress / time in the 
‘Light Plan’.

• When the ‘Light Show’ has been fully played, the ‘needle’ jumps back
to beginning and the preview starts again from the beginning.The
‘Light Show’ is played once more and then stops.

• When ‘Enable Scene preview looping’ is enabled in the ‘Preferences’
window, the ‘Light Show’ will be repeated over and over. For this refer
to 8 ‘Preferences’.

Click ‘ ’ to stop the preview.

10.3.1 Fixture Properties
Right click in the fixture rectangle in a ‘Light Plan’.
Select ‘Fixture Properties’ in the window that appears.
• The ‘Edit’ screen appears.

For editing ‘Fixture Properties’, refer to 9.2.2 ‘Editing Fixture
settings’.
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10.3.2 Resize Fixture Display
Resizing can be useful to scale the ‘Light Plan’ depending on the
amount of ‘Fixtures’, to deviate between models and turn
(e.g. 140 x 70 to 70 x 140).The minimum width and height are set to
20 and 200 pixels.

Right click in the fixture rectangle in a ‘Light Plan’.
Select ‘Resize Fixture window’ in the window that appears.
• The ‘Risize Fixture’ screen appears.
You can now adjust ‘Width’ and ‘Heith’ of the fixture rectangle in
the ‘Light Plan’.
Click ‘OK’ to save your settings.

10.3.3 Identify Physical Fixture
If the selected rectangle represents an unassigned fixture (no ‘Short
Address’) this menu item is disabled.

Right click in the fixture rectangle in a ‘Light Plan’.
Select ‘Identify Physical Fixture’ in the window that appears.
• Two colors are now be send, with a short delay between them, to the

assigned ‘Short Address’. If the DALI gateway and DALI network are
up to date one fixture blinks so you can match the ‘Light Plan’ with
the physical ‘Light Plan’.

Click ‘OK’ to save your settings.3
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11 Uploading a Light Show

The ‘Light Show Upload’ function sends all ‘Scenes’ to the ‘Fixtures’.

Note:
The upload process uses the DALI gateway (RS232 to DALI
gateway) to send data to the fixtures.There is no validation if the
fixture receives data and uploading a ‘Light Show’ to an unassigned
‘Short Address’ will therefore not result in an error message.

Make sure to run ‘Discovery’ first in order to keep a valid list of
‘Short Addresses’. For this, refer to 9.3 ‘Discovery’.
Open the ‘Light show’ you wish to upload.
Select ‘Upload’ in the ‘Light show’ menu.
• The ‘Upload LightShow’ screen appears.
Click ‘Start’ to start the upload.

• Upload starts with the first ‘Sequence’, the assigned ‘Light Group’ and
the first fixture inside that ‘Light Group’.
To that fixture the assigned ‘Time Line’ for the first ‘Scene’ is send,
then the second ‘Scene’ looping all ‘Scenes’. After this first fixture the
‘Light Group’ is checked for more fixtures sending the same ‘Time
Lines’ as to the first fixture.When all fixtures in the first ‘Light Group’
are uploaded, the same procedure is started for the second
‘Sequence’.

• A progress bar indicates how far the upload process is completed per
fixture. A label indicates the total number of fixtures and the current
fixture.

Fixture 2 of 3 with a progress bar at 50% means that the upload to
the first fixture is complete, the second is busy and the third still has
to start.

• Click ‘Cancel’ if you wish to stop the upload.
• After the upload to the current fixture is finished, the rest of the upload

will be cancelled.
This is done to prevent incomplete / corrupt data on the current
fixture.
• The following screen appears when the ‘Light Show’ is completely

uploaded.

Click ‘X’ to exit the upload procedure.5
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12 Basic presets in the Actilume Color
controller

12.1 Basic Philips T5 lamp settings

Lamp Lamp  Color x y Y [lm]
power type
[W]
14 T5 Red 0,565 0,328 900
14 T5 Green 0,319 0,530 1675
14 T5 Blue 0,156 0,076 310
24 T5 Red 0,565 0,328 1400
24 T5 Green 0,319 0,530 2750
24 T5 Blue 0,156 0,076 550
28 T5 Red 0,565 0,328 1800
28 T5 Green 0,319 0,530 3350
28 T5 Blue 0,156 0,076 625
54 T5 Red 0,565 0,328 3450
54 T5 Green 0,319 0,530 6900
54 T5 Blue 0,156 0,076 1500

12.2 Static presets

1 - RED
2 - GREEN
3 - BLUE
4 - Yellow
5 - Cyan
6 - Magenta
7 - Orange
8 - Aquamarine
9 - 6500K (Cold white)
10 - 3000K (Warm white)

12.3 Dynamic presets (sequences)

A sequence consists of a ‘Fade’ and ‘Hold’ period. For example:
‘Sequence’ 1 fades to ‘RED’ in 1 second and stays ‘RED’ for 1 minute
and  4 seconds, then fades to ‘GREEN’ in 1 minute and 4 seconds and
stays ‘GREEN’ for 1 minute and 4 seconds, and so on…

Sequence 1
RGB = 10 min (total time of one sequence):
Fade Hold
1 min 40 sec 1 min 40 sec RED
1 min 40 sec 1 min 40 sec GREEN
1 min 40 sec 1 min 40 sec BLUE

Sequence 2 
Color circle = 10 min
Fade Hold
50 sec 50 sec RED
50 sec 50 sec YELLOW
50 sec 50 sec GREEN
50 sec 50 sec CYAN
50 sec 50 sec BLUE
50 sec 50 sec MAGENTA

Sequence 3 
Nature = 10 min
Fade Hold
1 min 15 sec 1 min 15 sec GREEN
1 min 15 sec 1 min 15 sec CYAN
1 min 15 sec 1 min 15 sec BLUE
1 min 15 sec 1 min 15 sec AQUAMARINE

Sequence 4 
Spring = 10 min
Fade Hold
2 min 30 sec 2 min 30 sec YELLOW
2 min 30 sec 2 min 30 sec GREEN

Sequence 5 
Summer = 10 min
Fade Hold
1 min 40 sec 1 min 40 sec GREEN
1 min 40 sec 1 min 40 sec 3000K
1 min 40 sec 1 min 40 sec RED

Sequence 6 
Autumn = 10 min
Fade Hold
1 min 40 sec 1 min 40 sec YELLOW
1 min 40 sec 1 min 40 sec ORANGE
1 min 40 sec 1 min 40 sec RED

Sequence 7 
Winter = 10 min
Fade Hold
2 min 30 sec 2 min 30 sec BLUE
2 min 30 sec 2 min 30 sec 6500K

Sequence 8 
X-mas = 10min
Fade Hold
2 min 30 sec 2 min 30 sec GREEN
2 min 30 sec 2 min 30 sec RED

Sequence 9 
Cold-Warm white = 10 min
Fade Hold
2 min 30 sec 2 min 30 sec 6500K
2 min 30 sec 2 min 30 sec 3000K

Sequence 10 
Various = 10 min 
Fade Hold
30 sec 30 sec RED
30 sec 30 sec YELLOW
30 sec 30 sec GREEN
30 sec 30 sec CYAN
30 sec 30 sec BLUE
30 sec 30 sec MAGENTA
30 sec 30 sec 3000K
30 sec 30 sec 6500K
30 sec 30 sec ORANGE
30 sec 30 sec AQUAMARINE
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13 Actilume Color datasheet

13.1 Compliances and approvals

• RFI<30 MHz: EN 55015
• RFI>30 MHz: EN 55022 A
• Immunity: EN 61547
• Safety: EN 61347-1

EN 61374-2-11 (SELV Equivalent)
NEMA 410
UL935

• Quality standard: ISO 9001
• Environmental standard: ISO 14001
• Approval marks: ENEC:

72/23/EEC (low voltage)
89/336/EEC (electromagnetic
compatibility)
CSA
UL-recognized (UL1310 for class II
power supplies)

• CE marking

13.2 Technical data for installation

• Power operation: rated power voltage 120-277 V
• With tolerances for safety: +/- 10% 100-300 V
• Power frequency: 50/60 Hz
• Output power (system):

- R output: maximum 10 DALI loads (20 mA)
- G output: maximum 10 DALI loads (20 mA)
- B output: maximum 10 DALI loads (20 mA)
- Ext output: maximum 40 DALI loads (80 mA)
- DMX: 64 mA
- Sensor: 5 mA

13.3 Technical data for design and mounting in fixtures

• Operating conditions: ambient temperature 0 ºC to 50 ºC
(32 ºF to 122 ºF) controller and sensor

• Rel. humidity operating: 20 % to 85 %, no condensation
• Tcase: 75 ºC (167 ºF) 
• Storage conditions: -25 ºC to +70 ºC (-13 ºF to +158 ºF)
• Relative humidity storage: 10 % to 95 %
• Lifetime: 10 % failure rate at 50k hrs with Tcase

of 75 ºC (167 ºF) 

13.4 DMX operation
• Operating temperature: +0 … 50 ºC (32 ºF to 122 ºF) 
• Protocol standards: ANSI 1.11-2004 (USITT DMX512-A)

ANSI 1.20-2006 (RDM)
• Connector: 8-position modular connector (RJ45)
• Transient / Burst Immunity

and Surge: IEC 61000-4-4/5, level 2 on IO: 0.5kV
UL840: overvoltage category II
(< 50V): 0.5kV

• Network requirements: according to EIA-485-A specification 

13.5 Controller unit LLC1670/00

In DALI operation and based on the pre-programmed colors,
Actilume Color calculates the different dim levels for the Red, Green
and Blue lamps, and the fading (dim levels) in between two color
points. On the extended output, additional DALI loads can be
operated within the same ‘Sequences’ or ‘Scenes’. Moreover, this
output can also be used to connect additional Actilume Color
controllers to create larger set-ups.
In DMX operation, the real time DMX commands are directly
translated into DALI commands on the outpuit side.

13.5.1 Actilume Color interfaces

- 4x DALI current limited outputs
• DALI-R: 10 DALI loads max
• DALI-G: 10 DALI loads max
• DALI-B: 10 DALI loads max
• DALI-EXT: 40 DALI loads max (mentioned as group RGBE_DA)

- 1x Actilume Multi-Sensor input, called SENSOR

- 1x RS-485 connection, based on DMX(-RDM)
• The controller only supports the RDM address setting.

The RDM requires bidirectional RS-485 (half duplex) and a factory
programmed device unique ID.

• Transmission load: 32 devices, with terminators.
Transmission level range: 0 ≤ V ≤ +6 wrt common.
Transmission frequency: 250 kBits/s ± 2%.
Reception level range: +12/-7 wrt common
Reception frequency: 250 kBit/s ± 2,5%.

• Turn around time of DMX transceiver: 176 Ì s after transmission
of the last stop bits.When a DMX-RDM controller expects a
responds, the device must place it’s transmitter in high impedance
state within 88 us after transmission of the last stop-bit (of the
last transmitted byte).Time between slots (data-bytes) may not
exceed 76 us.

- 1x DALI passive input, (DALI GP)
• Transmit:

- short circuit current: max 250mA
- high level range: 11.5 … 20.5V
- low level range: - 4.5 … 4.5V
- rise/fall time: 10 …50 Ì s
- transmission frequency: 1200Hz +/- 5%

• Receive:
high level range: 9.5 … 300V
low level range: - 6.5 … 6.5V
rise/fall time: 10 …50 ms (power), 0 …100 Ì s

(DALI)
reception frequency: 50/60 Hz (power), 1200 Hz +/- 10%

(DALI)

- 1x Universal power input
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13.5.2 User interfaces 
- Remote control:

IRT1670/00 needs to be pointed to the sensor (IRR1651/00 or
IRR1654) for starting dynamic sequences or static scenes.

- DALI (102) based controls (e.g. Philips MultiDim):
Broadcast commands will start pre-programmed sequences/static
colors.

- DALI COLOR (209) based controls (expected for 2009):
DALI Color commands will activate Actilume Color and all other
(Lamp/LED) drivers based on DALI Color.

Mounting The minimum distance between the
fixation holes is 236 mm (9.2913").

13.5.3 Safety 
• Glow wire test: 850 ºC / 5 s
• Safety, basic insulation: < 2000 V

13.5.4 Housing
• Material Polycarbonate + ABS Bayblend KU-2

1514, UL94 V-0
• Housing color Dark grey

13.5.5 Mounting
The minimum distance between the fixation holes is 236 mm (9.2913").
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13.5.6 Connections for DALI and power

• IDC Connection: 0.5 mm (0.02") - 0.75 mm2 (*)
ADS or manual push wire
insert 0.5 mm (0.02") - 1.0 mm2

(0.00155 sq inch)
(*) Stranded wire

• Strip length: 8.0 - 9.0 mm  (0.315 - 0.3543")

13.5.7 IR sensors
- Sensor IRR 1651/00 without cap
- Sensor IRR 1654/00 with cap
- Sensor IRR 8125/10 invisible

• Connection RJ-10 4-Pole
100 cm cord

• Housing (casing)
• Material Polycarbonate UL94 V-0
• Glow wire test 950 ºC / 5 s
• Safety, basic insulation < 2000 V
• Infrared receiver RC5 signal

Minimum range 20 m2

• Cap material IRR1654 polycarbonate, RAL7035

13.6 Advanced color selection remote control IRT1670/00
This remote control can be used for
selecting pre-programmed color sequences
and static colors.Already programmed
dynamic sequences can be played faster 
(in half of the time), or slower (factor 3 or 6
slower). Static colors can be selected in hue
and dim level and stored into the controller.

Batteries are included.
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13.7 Actilume Color Studio, programming software
LCS1670/00

Actilume Color Studio is intuitive software for programming
sequences into the Actilume Color controller. It allows direct preview,
light plan overview, and grouping.

13.8 Gateway

LCU1670/00 (230V) and LCU1671/00 (24V)

The RS232 – DALI Gateway translates all communication between
the personal computer and the DALI network.The connection
between PC and the DALI network is only necessary when the
sequences are uploaded into the Actilume Color Controller.
Two versions: 230V and 24V

230V gateway LCU 1670/00 24V gateway LCU 1671/00

RS232

RS232

DALI Test Master

DA-

230VAC/50Hz
N

L  

DA+

14 Ordering data

Product description Weight Packaging  EOC
(kg) (pcs)

Controller LLC1670/00 0.107 24 915 719 30
IR Sensor IRR1651/00 0.026 48 730 639 99
IR Sensor IRR1654/00 0.027 24 915 856 30
IR Sensor IRR8125/10 0.028 1 731 315 99
Remote control IRT1670/00 0.030 18 915 832 30
Gateway LCU1670/00 and 
Actilume Color Studio 
CD LCS1670/00 0.442 1
Gateway LCU1671/00 and 
Actilume Color Studio 
CD LCS1670/00 0.177 1 
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